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Learning Objectives

Learners will identify which fonts, colors and spacing in Word documents are best for people

with low vision.

« Learners will distinguish between headings and styles and experiment with modifying a given

document to be accessible for someone using a screen reader.

» Learners will identify what type of structure is needed to make a Word document accessible

and how to add structure to documents.

» Learners will create accessible hyperlinks, tables and graphics placed in a Word document.

» Learners will identify how to check Word documents for accessibility and how to export them

to PDF while keeping the accessibility.
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Font

Sans serif fonts

Arial
Calibri
Candara
Corbel
Tahoma
Verdana

Size: at least 12 point
Emphasis:
 *Asterisks

» -Dashes

* “Quotes”

» Underlining




Contrast

Plain background with black + Look for high contrast

. teg’:cf white between background and

+ Cream 12

* |vory » Check your contrast with the
* Yellow free Colour Contrast

* Pink

Analyzer




Create a High Level of Color Contrast

(black)

« Ratio of 7:1 for normal text

v
Background colour (white)

HEX v #FFFFFF

* Ratio of 4.5:1 for large text

1l
©

¥ Sample preview

example text showing contrast ]]ﬂ\]]"Jl

« Download for Windows

WCAG 2.1 results Contrast ratio
21:1

d M » 1.4.3 Contrast (Minimum) (AA)
a n a C ) Pass (regular text) ) Pass (large text)

» 1.4.6 Contrast (Enhanced) (AAA)

@ Pass (regular text) @ Pass (large text)

) Might need permiSSionS » 1.4.11 Non-text Contrast (AA)

@ Pass (Ul components and graphical objects)
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https://www.tpgi.com/color-contrast-checker/

The Screen Reader Challenge

To see why creating accessible documents is important,

check out this 3-minute video of a screen reader going

through accessible and inaccessible Word

Documents. And here is an example of a screen

reader going through an inaccessible PDF.



https://www.youtube.com/watch?v=D8XFkGMF0sw
https://www.youtube.com/watch?v=GaNwnsT4B5s

Spacing

Avoid: Use:

* Blank spaces  Indentations

* Blank lines * Line spacing tool
« Styles

* Page breaks
« WYSIWIG (])
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Examples from Microsoft

Ll

Division-Annual-Reportq

"This-year-has- seen- many- changes- in- our- procurement- process - We- have- eliminated-
excess- competition: by-firing- all- of the- unhappy-dogs .- Ve -have-streamlined-the-process-
by channeling- over- 90%: of the- affection- towards - yours- truly.- This- is- excellent- progress-
for-our-division."

--Fasltel-Bosken, AAP-DCY|

Reporthighlightsy

Section Break {Continuous)

This-report-is the-first-in-a-series-of-annual-
reports-from-the-newly- crated- Affection- &
Attention- Procurement- Division. This-report-
details-the two-major-accomplishments- this-
year:-(1)-Steps taken to-identify-and- retrain’-

{fire)-unhappy- dogs-at-the- Agency, and-
(2)-Stepstaken-to-retrain- those who-
have-been-hesitant-to-provide-AA for-
guide-dogs .

Section Break {Continuous) .

Contentsq

- - - - -+ + -+ - Division-Annual-Report.

Pu)

Pu)

Pu)

Pu)

1
-+ "This- year- has- seen- many- changes- in- our procurement- process. - We  have«
-+ eliminated- excess competition: by firing- all- of the- unhappy- dogs. - We- have«
- streamlined- the- process: by channeling: over- 90%- of- the- affection- towards: yours+
- fruly.- -This-is-excellent: progress for-our-division.” 9

1

1

1

1

= - Reporthighlightsy

1

1
-+ This-reportisthe-first-in-a-series-of -annual- |- -ments-this-year:-{1)-Steps taken-to 1
- reports-from-the-newly: created-Affection- |- identify- and-'retrain’-(fire)-unhappyql
- &-Attention- Procurement Division - This -1 -dogs-at the- Agency, and-(2)- Steps
- report-details-the two-major-accomplish-------1 - taken-to-retrain-those who-have- beent
- - - - - - - oolechesitant to-provide- A for-guide dogs g

1

1

1

1

= - Contentsq

T T T e ST


https://www.ssa.gov/accessibility/checklists/docs/RepeatedBlankChar_eg_correct.docx
https://www.ssa.gov/accessibility/checklists/docs/RepeatedBlankChar_eg_incorrect.docx

Spacing Tips

White space creates
luminance

Indent 1 inch at margins
Space 1.5 between lines

Double space between

paragraphs

» Use block paragraph
style, no indents, aligned
left

 Avoid floating objects by

using text wrapping




Page Numbers

« Same font style and
size as document

text File Home m Design  Layout  References Mailings Review View Help Acrobat % Share X Comments
71 IO Shapes v b= = 1 o o+ [® Header v ]
B H | o s P Q|2 Ed| ] sARREe.

L cons ) Footer ~
® TO rl ht CO rn e r Pages Table Pictures . Reuse Add- Online Links Commen t Text Symbols
v v ~ D) 3D Models ~ [ T Files ins ~ Video ~ ‘ Page Number v ~ v
p refe rred Tables llustrations Reuse Files Media Commen ts Header & Footer o~
L i, c o o [ o o o Y 2 3

« Margin of .075 :
iInches :

« Table on contents
for long documents
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HEADINGS

\
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Structure

* Use prescribed logical » Organize information into

order small chunks

* Firstlevel should be « Each heading including

Heading 1
only a few paragraphs

« Limit yourself to 2

headings; 3 occasionally




Examples

Vegetables from Wikipedia (heading 1)

Brassicas (heading 2)

Brassica is a genus of plants in the mustard family (Brassicaceae). The members of the genus
are informally known as cruciferous vegetables, cabbages, or mustard plants. Crops from this
genus are sometimes called cole crops—derived from the Latin caulis, denoting the stem or
stalk of a plant.

Tubers

Tubers are enlarged structures in some plant species used as storage organs for nutrients.
They are used for the plant's perennation (survival of the winter or dry months), to provide
energy and nutrients for regrowth during the next growing season, and as a means of asexual
reproduction. Stem tubers form thickened rhizomes (underground stems) or stolons (horizontal
connections between organisms). Common plant species with stem tubers include potato and
yam. Some sources also treat modified lateral roots (root tubers) under the definition; these are
found in sweet potatoes, cassava, and dahlias.

Leafy Greens

Leaf vegetables, also called leafy greens, salad greens, pot herbs, vegetable greens, or simply
greens, are plant leaves eaten as a vegetable, sometimes accompanied by tender petioles and
shoots. Although they come from a very wide variety of plants, most share a great deal with
other leaf vegetables in nutrition and cooking methods.

Academy

Vegetables from Wikipedia (heading 1)

Brassicas (heading 3)

Brassica is a genus of plants in the mustard family (Brassicaceae). The members of the genus
are informally known as cruciferous vegetables, cabbages, or mustard plants. Crops from this
genus are sometimes called cole crops—derived from the Latin caulis, denoting the stem or
stalk of a plant.

Tubers

Tubers are enlarged structures in some plant species used as storage organs for nutrients.
They are used for the plant's perennation (survival of the winter or dry months), to provide
energy and nutrients for regrowth during the next growing season, and as a means of asexual
reproduction. Stem tubers form thickened rhizomes (underground stems) or stolons (horizontal
connections between organisms). Common plant species with stem tubers include potato and
yam. Some sources also treat modified lateral roots (root tubers) under the definition; these are
found in sweet potatoes, cassava, and dahlias.

Leafy Greens

Leaf vegetables, also called leafy greens, salad greens, pot herbs, vegetable greens, or simply
greens, are plant leaves eaten as a vegetable, sometimes accompanied by tender petioles and
shoots. Although they come from a very wide variety of plants, most share a great deal with
other leaf vegetables in nutrition and cooking methods.



https://docs.google.com/document/d/16WxBCGky3BeAeBMjNPa2KgBjP1Sl0lQwF1stTXe__BQ/edit
https://docs.google.com/document/d/1U3BPNCICDXt39_tglBGTs2dRlrmsxW0drF75LzoSZCc/edit

Heading Suggestions

+ Heading 1: 22-point font, - Heading 3: 20-point font,

centered, bold, upper- and aligned left, bold, underlined,

upper- and lower-case letters
lower-case letters

* Normal: at least 12-point font

« Heading 2: 20-point font,

(18-point for large print),

aligned left, bold, upper- and aligned left

lower-case letters




Assigning Styles

Simple Solution * Pros
* Done on the fly
+ Type the text * Worry about it later

« Often what you receive

o Select the text * Cons

* Forget to do it later

« Select the heading style _ _
* More labor-intensive
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Modifying Styles

« Select the item you want to change

(ex. Heading 1)

* Click Modify
« Make formatting changes

 Choose style applies to:

« Current document

e All future documents

Modify Style ? *
Properties

MName: Heading 1

Style type: Linked (paragraph and character)

style based on: T Mormal I

Style for following paragraph: | T Normal

<

erdana (Headings) >~ |24 |~ | B I U Automatic ~

Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text

Font: (Default) +Headings (Verdana), 24 pt, Centered, Space ~
Before: 12 pt
After: 0 pt, Keep with next, Keep lines together, Level 1, Style: Linked, Show in the Styles gallery,
Priority: 10

Add to the Styles gallery | Automatically update

(O only in this document  @)iNew documents based on this template:
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Creating Styles

Document1 - Word

Home Insert BGSLIM Layout References Mailings

Review View Acrobat

I it T e
a 3 TLE
u Heading 1 .

Themes

Document Formatting

Lovoo e e e e e 2 e

_ Colors Fonts

Office

Aa

Aa

Aa

Aa

Aa

Aa

Aa

Aa

=# Paragraph Spacing ~

I:‘ Effects =

Set as Default

Office
Calibri Light
Calibri

Office 2007 - 2010
Cambria
Calitari

Calibri
Calibri
Calibri

Ari_al
Arial
Arial

Corhel
Corbel
Corbel

Candara
Candara
Candara

Franklin Gothic
Franklin Gothic M...
Franklin Gothic Book

Century Gothic ‘
Cenfury Gothic
Century Gothic

Customize Fonts...

[+

Q Tellme Leann

al O

Watermark Page Page

Color ~ Borders
| Background ~

Heading font:

Yerdana

Eody font:

Yerdana

Mame:

Low Vision Accessible

Sample

Heading

Body text body text body
text. Body text body text.

S

Save Cancel



Permanently Change Font

Document1 - Word

Home Insert QBGESLIM Layout References Mailings Review View Acrobat QT&II me Leann

Academy

I it T
a 3 TLE
u Heading 1

Themes

=# Paragraph Spacing - D
M I:‘ Effects =
. - Set as Default

Document Formatting Office
2.

Office
Calibri Light
Calibri

Aa

Office 2007 - 2010
A Cambria
a Calitari

Calibri
Calibri
Calibri

Aa

Arial

A Arial
a Arial

Corhel
Corbel
Aa Corbel

Candara
Candara
Aa

Candara

Franklin Gothic
A Franklin Gothic M...
a Franklin Gathic Baok

Century Gothic ‘
A Cenfury Gothic
a Century Gothic

Customize Fonts...

a [0
- Colors ' Fonts Watermark Page
Color ~ Borders

| Background

Page

6 . . .

Heading font:

Yerdana

Eody font:

Yerdana

Mame: Low Vision Accessible

Sample

Heading

Body text body text body
text. Body text body text.

Save Cancel



Permanently Change Styles

 Documents you create

Font: t style: Size:
have this as the default. S —
:mbe [ Bold Italic g
geria | Er—
« Does not affect documents
. Eﬁgssmkg 0 ;:';:::;"::t:t:;:z; on the Normal.dotm template?:
you receive from others. S I
[ subscript
Pr
* Does not affect documents S .. Z—

you previously created.
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DOCUMENT STRUCTURE

\
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Lists

. Use built-in List tools Do not use:

* Hyphens, characters or

* Break up and simplify graphics as bullets

content . Tab
« Use plain, round dots  Tables
* Text boxes

« Use numbers, letters and
* Spaces

Roman numerals




Columns

Use: Do not use:

» Page Layout * Tables

- To break-up and simplify * Tabs
content » Spaces

 Text boxes




Headers, Footers, and Watermarks

Use header or footer for:
* L etterhead logos
* Page numbers

Duplicate watermark at or

near the start of main

content.

These are not
automatically read with a

screen reader.

Do not place vital content

In header or footer.




Tables

« Create using Table Insert * Leave no cell blank

* Keep data tables simple - Complex tables are not
 |dentify header row accessible

 Place table in-line with text * If more than one page,

« Keep tables to one page repeat column headings




HYPERLINKS,
ALTERNATE TEXT AND
LANGUAGE

\
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Hyperlinks

More about APH

Link to: Text to display: | < <Selection in Document> > ScreenTip... . ) . . . o .
= Find APH's main website with information
£ in: = W Iy .
Existing File or | 00K ™ § Doctets Q about products, services, and other
Web Page Custom Office Templates A Bookmark.. resources
; Current Folder Fax - ulCeEs.
% o . .
Place in This | <=l My Data Sources Target Frame... Ct rl +CI|C|( to fD”DW ||n|(
Document My Kindle Content

S e B ook s More about APH

Scanned Documents

Create New .
= Screencast-O-Matic

Document f
Recent Files Scnvgner -
0 Tutorial.scriv "y
E-mail Address Address: https://www.aph.org/ Remove Link

Academy




Alternate Text

« Short and simple Instructional images essential

. Leave title field blank to understanding content:

+  SmartArt graphics need ust provide additiona

iInformation if not in the main
alternate text

text.

« Use Text Wrap Style when _ _
* If in the main text, use

placing images

simple, less detailed alt text.




Language

« Foreign language « Select the text that is
documents written in a different
anguage

* Multiple languages in one
document  Review>Language>Set

Proofing Language
« References that are in

« Select the appropriate
another language ppropr

language




ACCESSIBILITY CHECK
AND EXPORTATION

\
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Check Headings

* Navigation Pane
» Control+F

* View>Navigation

Pane

Academy

AutoSave g ©9©v0 =

File Home Insert References

DEI E i [E] outline S
. :‘D E]Draf‘t L.J

Design  Layout

) |lE)E2

Read | Print | Web Focus Immersive | |Mertical| Side
Mode |Layout| Layout Reader to Side
Views Immersive Page Movement
. . L S
Navigation v X
Search document L~ i
Headings Pages Results B
4 Building Accessible Word Documents
Visual Accommodations vr
Headings -
Document Structure _
Hyperlinks )
Alternate Text -
Language m

Accessibility Check
Exportation to PDF
Websites

Mailings

Creating Accessible Wo... ~ ,O

Review View Help  Acrobat
~| Ruler Q D E] one P
Gridlines 100 EE Multip
Zoom 100% -
~| Navigation Pane <= Page V
Show Zoom

I T N T T T SR R T IR

W MR TR I W EWT ¥ M el I MR a) 0

for people who are deaf or hay

Language

e Documents can contain sectiol

e [dentifying distinct languages «

e Technical terms or foreign wor

rule.

e Setting the correct language
o Select the text written ir
o Go to Review>Language
o Select the appropriate Ik

Accessibility Check

e Navigation Pane to check for h




Properties

Fill out Properties Properties ~
Size 21.9KB
¢ T|t|e Pages 7
Words 1283
° TagS Total Editing Time 1905 Minutes
Title Creating Accessible Word ...
Tags Styles, Headings, Hyperlin...

¢« Comments

Comments Add comments

Academy




Accessibility

Check the document name: Check accessibility:

« Simple * File>Info>Check for

» Easy to remember Issues> Check
Accessibllity

* Free of special

characters * Not a robust system




Exportation -

| < v 4 & * This Search Documents
PDF Options
u [—
F I I e > S ave AS > P D F Organize ¥ New folder [] Convert document information == - e
[ ] Create PDF/A-1a:2005 compliant file i _ Al
S modified ype |
& This PC Enable Accessibility and Reflow with tagged Adobe PDF I "
|
Select Options 3 0 o
B Desktop [v] Convert Word Headings to Bookmarks 2020 3:20 PM File folde
D Convert Word Styles to Bookmarks | . - _
= Documents jo2 File folde
: [ ] convert Word Bookmarks %03 et
guZl File Tolae
¥ Downloads [v] Convert Comments
. 2021 10:46 PM File folde
D Music _
2021 4:44 PN File folde
= Pictures . )
D20 9:30 PM File folde
E Videos F2N10 92N DA Fila frnlde 7|
Wlind mae 70 Page range o
File name: | Creatin = ~
() Current page
Save as type: |PDF file Selection ~
() Page(s) 3 - 5 -
oK Cancel
"\."'e'.-'."
~ Hide Folders Options Save Cancel
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References

* https://aphaccessibility.com/checklist-for-ms-word-docs-home/

* https://webaim.org/techniques/word/

* https://www.hhs.gov/web/section-508/making-files-accessible/create-

accessible-pdfs/step-2/index.html

* https://www.mtu.edu/accessibility/training/documents/microsoft-word/

* https://sbctc.instructure.com/courses/1578604/pages/creating-

accessible-word-documents



https://aphaccessibility.com/checklist-for-ms-word-docs-home/
https://webaim.org/techniques/word/
https://www.hhs.gov/web/section-508/making-files-accessible/create-accessible-pdfs/step-2/index.html
https://www.mtu.edu/accessibility/training/documents/microsoft-word/
https://sbctc.instructure.com/courses/1578604/pages/creating-accessible-word-documents

References, continued

* https://www.wikihow.com/Create-Accessible-WWord-Documents

* https://web.wsu.edu/creating-an-accessible-microsoft-word-

document/

 https://support.microsoft.com/en-us/topic/make-your-word-
documents-accessible-to-people-with-disabilities-d9bf3683-

87ac-47ea-b91a-78dcacbh3cb6d

* https://www.washington.edu/accessibility/documents/word/



https://www.wikihow.com/Create-Accessible-Word-Documents
https://web.wsu.edu/creating-an-accessible-microsoft-word-document/
https://support.microsoft.com/en-us/topic/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://www.washington.edu/accessibility/documents/word/

CONTACT US

Building Accessible Word Documents

Leanne Grillot, |grillot@aph.org

Tai Tomasi, ttomasi@aph.oro
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